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ABSTRACT
THE EFFECT OF COMPACTION TEMPERATURE AND PRESSURE ON MECHANICAL
PROPERTIES OF 3D PRINTED SHORT GLASS FIBER COMPOSITES
Pushpashree Jain Ajith Kumar Jain
Old Dominion University, 2020
Director: Dr. Oleksandr Kravchenko
Among many thermoplastics that are used in engineering, polyamide 6 (nylon 6) is an
extremely versatile engineering thermoplastic. Nylon filled with glass fibers has higher mechanical
strength and high wear resistance than general purpose nylon. 3D printed composites, based on
fused filament modeling, typically suffer from poor bead-to-bead bonding and relatively high void
content, limiting their mechanical properties.
This thesis explores the effect of compaction pressure and temperature on improving the
mechanical properties of 3D printed composites. Engineering moduli in the printing and transverse
to printing direction, as well as ultimate strength were measured using the tensile testing with
Digital Image Correlation (DIC). Tensile testing is performed on the samples that are compacted
at different temperatures with pressure. In addition, microscopic studies were carried out to
evaluate the void content for different compaction pressures and temperatures. Fiber orientation
state was measured for different sets of samples. Differential scanning calorimetry (DSC) was
carried out to calculate the degree of crystallinity and possible changes in crystalline morphology
as a result of annealing temperature profile.
The results indicate that by selecting appropriate heat treatment profiles both strength and
modulus of 3D printed composites can be significantly improved. Strength was improved by over
50% and 100% in printing and transverse directions respectively, and twofold increase of the
modulus in printing direction was found. In this respect, the observed mechanical behavior will be
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explained in terms of various parameters such as degree of compaction, crystalline structure,
orientation state and void content.
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TERMINOLOGY
PA 6: Polyamide 6/Nylon
PS: Pristine
AN: Annealing
AC: Annealing with compaction
00: Samples with 0-degree print orientation
90: Samples with 90-degree print orientation
DIC: Digital Image Correlation
DSC: Differential Scanning Calorimetry
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CHAPTER 1
INTRODUCTION
Traditional fabrication processes for composite materials, such as autoclave molding
prepreg laminates have geometrical restrictions and are very labor intensive [1]. Injection and
compression molded composites allow geometrical complexity but do not have as desirable
material properties as prepreg laminates due to poor control of fiber orientation [2]. With these
disadvantages of conventional manufacturing processes, there is a need for a fabrication process
that can create complex geometries yet still retain the control of fiber orientation to achieve the
desired material properties.
Fused deposition modeling (FDM) 3D printing is an additive manufacturing (AM) process
in which a filament is extruded through a heated nozzle to build an object layer by layer. This
process has recently gained interest due to its versatility, ability for rapid prototyping of
geometrically complex parts and the ability to create parts which were not previously possible.
Generally, the filament used is a thermoplastic, however, composite filaments also exist.
Discontinuous-fiber reinforced composites can now be 3D printed by first creating a filament
which contains discontinuous-fibers [3]. Continuous fiber composites can also be 3D printed. Two
common methods for printing continuous fiber composites are dual extrusion, in which the fiber
and matrix are extruded separately, and nozzle impregnation [4].
The mechanical properties of 3D printed polymer parts have been studied by many authors.
Parameters such as printing direction, layer thickness, infill degree and feed rate have a
considerable effect on the quality and performance of 3D printed polymer parts [5],[6],[7].
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Thermoplastics are used in a wide range of applications because of their high strength,
lightweight and relatively low processing costs and PA 6 is one of them. Additionally, nylon-glass
fiber composites exhibit excellent strength and good dimensional stability compared with
unmodified grades of nylon [8]. Nylon-glass fiber is a high-quality filament with short fiber
reinforcement, which is odorless during the extrusion process [9]. Glass fiber filament is ideal for
engineering prototypes that require structural mechanical properties and heat resistance [10].

Figure 1:Micrograph depicting the layer arrangement and interlayer voids. [12]

Figure 2: Micrograph of a laminate made of glass fiber/nylon composite [13]
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With the recent advancement of 3D printing, polymer composites can be fabricated rapidly
for structural and prototyping purposes. However, the mechanical properties of 3D printed
polymer composites are typically lower than in composites manufactured using injection molding
process. One of the reasons is due to poor degree of bonding between the individual deposited
beads (Fig 1) [11],[12]. When the material is printed layer by layer by extruding the filament, the
final parts of the material are very porous (Fig 2) [13]. Also, the 3D printed nylon-glass fiber
composites inherently exhibit anisotropic properties due to the 3D printing. The short glass fibers
are aligned significantly along the printing direction [14]. Therefore, it is necessary to study the
effect of post treatment, such as annealing and compaction, on the mechanical properties of nylonglass fiber composite [15] both in-printing and transverse direction. The heat treatment of the 3D
printed composites is followed by heating the sample up to the specified temperature below its
melting point and held at that constant temperature for a period of time and then cooled to the
ambient temperature [16]. A change in the crystalline structure of the polymer can be observed
[17]. This treatment is well suited for the 3D printed parts which results in the release of residual
stresses induced during additive manufacturing. Annealing the polymer above the glass transition
temperature helps to recover the reduction of interlaminar tensile strength from the additive
manufacturing [17]. The focus of this research is to understand how these composites can be
strengthened by annealing and compaction. The strength of these composites was determined using
tensile testing. Tensile testing is one of the conventional methods used to find the mechanical
properties of the material. It provides information on the tensile strength and modulus of the
specimens. The fractured surfaces of these tensile tested samples were used to study the volume
fraction of the voids, as well as fiber orientation.
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CHAPTER 2

METHODOLOGY
The main aim of this thesis is to observe the change in strength of the glass fiber reinforced
PA6 composites. Samples treated at different temperatures and pressures are compared with the
pristine ones. Samples with 00 and 900 fiber orientation are considered for experiment. The setup
will be discussed, followed by the manufacturing and testing of materials.
A 3Dimensional object is processed from a computer file which consists of G code using
Prusa MK3 i3 3D printer (Fig 3), where the part is built by the deposition of material layer by layer
which is why it is also called additive manufacturing. The 3D CAD model with the necessary
dimensions is converted into a G Code file using Slicer and/or Ultimaker Cura software. The
parameters such as print speed, temperature of the extruder and the bed, flow rate, infill direction,
layer thickness is set using this software. In case of presence of excess material, it can be removed
by using water jet cutting which uses water of high pressure along with abrasive materials. This
kind of material removal is called subtractive manufacturing. ProtoMAX software is used to
control and guide the water jet cutting machine.
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Figure 3. 3D printer used for additive manufacturing

3D printed specimens were grouped into sets and each set of specimens is annealed and
annealed with compaction at different temperatures. Annealing was carried out in an oven.
Annealing with compaction was carried out using two different methods. The first method used
compression molding press to provide uniform heat distribution with controlled temperature and
pressure. Another method uses a pressure vessel called autoclave, which is the most common
method for curing composites. In the autoclave process, high pressure and heat are applied to the
part through the autoclave atmosphere. A specific compaction cycle can be programmed. A
vacuum bag was used to apply additional pressure and aid in composite consolidation and reducing
the void content.
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All the specimens including the pristine, annealed, annealed with compaction, are tested
using MTS. Here, the dog bone specimens are placed vertically using fixtures which are attached
to the top and bottom head of the MTS machine. When the tensile load is applied continuously,
the top head of the fixture moves gradually and stops when the material fails. Data such as force
applied, percentage of strain is recorded, stress vs strain curves are generated. Later, the modulus
value for each set of samples is calculated.
Digital Image Correlation (DIC) is an optical method which is used to measure the
deformation on an object’s surface. The movement of applied surface patterns is tracked during
the tensile testing using MTS. A series of images is obtained from the beginning till the end of the
experiment. It gives the strain values across the entire surface. The strength obtained from the MTS
and the strain from the DIC are plotted to get the modulus. This modulus from the DIC is compared
with the modulus obtained from the MTS.
All the data from the tensile testing was recorded through Testworks4 software which
controls the moving head of the tensile testing machine and is imported into MS-Excel. The stress
vs strain curves are plotted which gives the modulus. The stress, strain and modulus are compared
using a bar chart.
The fractured surfaces of the samples obtained from the tensile testing machine are studied
for the volume fraction of voids and fiber orientation. The samples were cut using a water jet cutter
up to 0.5” each including the fractured surface. The samples were polished to allow for
microstructural analysis. These polished samples were observed under an optical microscope and
the micrographs were analyzed using ImageJ software. ImageJ is an image processing software
where these 2-dimensional microscopic images can be studied by adjusting the threshold and by
finding the area of fibers, matrix and voids.
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Differential scanning Calorimetry (DSC) is carried out on the 3D printed samples to study
the temperature profile. DSC is used for a various application including the determination of heat
of fusion, crystallization, glass transition temperature Tg, oxidation and other chemical reactions.
A heat flow versus temperature curve is obtained from the DSC analysis. The degree of
crystallinity for the nylon can be calculated by using the net enthalpy values from the endothermic
and exothermic peaks obtained from the DSC curves.

2.2. Experiment Setup

2.2.1. Sample Manufacturing
The material used is XSTRAND GF30-PA6 with a filament diameter of 1.75mm and
melting temperature of 206C. This material comes in large rolls, in the form of filaments (Fig 4).
The filament is made up of Polyamide6/nylon matrix reinforced with 30% of glass fibers. The
filament is dried for up to 4hr in the oven at 80°C before using for better printing results. The
filaments were fed into the 3D printer where it is melted and is extruded in the form of layers [18].
The printing is carried out at a printing temperature of 250°C and at a speed of 30mm/s with a
printing bed at 90°C.
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Figure 4. Filament used for 3D printing [19]

The nylon glass fiber composites that are used for testing are manufactured in the form of
dog bones. The 3D model of each dog-bone specimen is designed using Autodesk Inventor and is
sliced using Ultimaker Cura. The sliced model is fed into the 3D printer in the form of g code.
Each dog bone model is manufactured using an additive manufacturing process in which it is 3D
printed layer by layer with a gage dimension of 60x10x3.2mm (Fig 6) with each layer thickness
being 0.2mm. The structure dimension of the specimen is followed by the ISO 527-2 which
provides similar results to the ASTM D638.
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b.
a.

c.

d.

Figure 5. a. Dimensional model designed using Autodesk Inventor; b. Preview of the sample
from the Ultimaker Cura; c. 3D printed sample; d. Painted samples before tensile test
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Figure 6:3D printed dog bone sample.

2.2.2 Heat Treatment
3D printed dog-bone samples are categorized into groups for the annealing process
with/without compaction as mentioned in the Table 1.
Annealing is one of the several heat treatment processes used in polymer manufacturing to
increase the strength of the materials. The annealing process has shown a great advantage when
applied to polymer composites, wherein the composite material becomes stronger after annealing.
This process will lead to increase in the properties of 3D printed samples by distributing the stress
more evenly thus decreasing its chances of quick fracture by increasing the tensile strength [20].
Annealing of the 3D printed samples was carried out in a closed oven. The oven is pre
heated up to 100C to 150C and then the samples were covered with a release film to prevent the
sample from adhering to the inner panel of the oven. Annealing the samples along with a pressure
of 80psi was carried out in a closed vessel called the autoclave. Annealing with compaction for
some of the samples was carried out using hot press (Fig 7). The heat press contains two heated
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platens. The vacuum bagging setup is placed between the heated platens as shown (Fig 8). The
pressure is applied in terms of tons of force by taking the surface area of the sample into
consideration. (1psi= 4.464E-4 ton-force/square inch). After the heat treatment, the heat supply for
the heated platens and the pressure are turned off. The samples are taken out only after they are
cooled down to a room temperature to avoid warping.

Figure 7: Heat press used for heat treatment.
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Figure 8:Vacuum bagging setup with heated platens.

Table 1: Number of specimens tested per group treated at different temperature and pressure

Print orientation

Annealed without

Annealed with Compaction (80

compaction

psi)

Pristine
150° C

170° C

200° C

150° C

170° C

200° C

0 degree

3

3

3

3

6

3

5

90 degree

3

3

3

3

6

3

5

2.2.3 Vacuum Bagging
Vacuum bagging is one of the most ancient and easiest methods to consolidate fiber
reinforced polymers. The 3D printed samples were placed on a base plate(aluminum) with a release
film on top and bottom in such a way that the sample, when heated at high temperature does not
stick to the base plate. The whole setup (Fig 9) is covered using a vacuum bag in which a breather
is used in between the sample covered with release film and the top vacuum bag layer. This
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breather enables the whole vacuum bag to path through the vacuum source. Volatile gases and air
can easily escape through this breather and the pressure applied can be distributed evenly
throughout the vacuum bag.

Figure 9: Vacuum bagging set up
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Figure 10:Vacuum bagging setup-before and after heat treatment

2.3 Tensile Testing
The tensile testing of the specimens was conducted using MTS with a load cell of 300kN
(Fig 11). The samples were designed in the form of dog bones and the tabs of the dog bones were
designed for easy gripping [21]. During tension, one of the tabs were attached to a fixed position
and the other attached to a crosshead moving at 0.2mm/min until the fracture of the sample (Fig
12). Each of these samples were clamped in fixtures that are designed for even load distribution
along the cross section of the specimen. The MTS machine used for tensile testing is equipped
with TestWorks4 software to achieve constant speed in tension.
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Figure 11: MTS machine used for tensile testing

Figure 12: Tensile testing setup with DIC
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2.4 Digital Image Correlation
Digital Image Correlation is a software used for optical tracking of the deformation of the
sample during tensile testing. The setup consists of an acquisition DIC software-GOM correlate, a
high-quality camera which is focused on the specimen (Fig 13). The area/region on the specimen
which is subjected to tensile load is selected (Fig 14), and then the whole cycle is recorded using
the software. The percentage strain along the length of the specimen is thus recorded from the
software at intervals of 10 seconds. The strain values from this are used to plot the stress vs strain
curves and to calculate the tensile modulus of each sample.

Computer with
DIC software

Loading system

Light source with
lens

Figure 13: DIC set up
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Figure 14:Image showing the strain rate recorded from the GOM software during tensile testing.

2.5 Microscopic Studies on Cross Section
The microscopic studies were carried out on the polished cross section of the Ny-glass
composite specimens using an optical microscope [22]. A small portion of the sample,
approximately 0.5” including the fractured end were cut using a water jet cutter and mounted in
resin for grinding and polishing. These polished samples are dried to obtain a clearer crosssectional image of the fractured surface (Fig 15). High quality images obtained from the
microscope are analyzed using ImageJ software.

18

Figure 15:Polished cross section micrograph captured from optical microscope

2.5.1 Evaluation of Fiber Distribution
The images captured from the optical microscope were saved in a jpeg format and imported
into the ImageJ software. These images were converted into grayscale (Fig 16) and the area of
fibers, matrix and the voids can be found by selecting the particles. In the (Fig 16), all the fibers
were shown in white and the rest of the black region consists of voids and the resin. The area of
the white region and the black region is calculated using ImageJ software which refers to the area
of the fibers and the matrix including voids respectively.
The image (Fig 15) is adjusted in such a way that the voids are represented in white and
the rest of the black region consists of fiber and matrix.
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Figure 16:Microscopic image showing the fibers in white.

Figure 17:Microscopic image showing the voids in white

2.5.2 Evaluation of Fiber Orientation
The fiber orientation is found using the same ImageJ software that was used to calculate
the volume fraction of voids. The image with higher magnification is used for analyzing the
orientation of fibers. The threshold of the micrograph is adjusted by following the same procedure
that was followed to find the volume fraction of voids as shown in figure (Fig 17). Each fiber
and/or void is selected, and the ellipses were fitted into the ellipses. The parameters such as area,
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length and width of the ellipse were recorded from the software Analyze>Analyze
Particles>Ellipses (Exclude on edges, Display Results). These parameters were used to calculate
the fiber orientation in each micrograph.
To find the fiber orientation in a composite.
The Formulae that are used are as follows:
𝒂𝟏𝟏
𝑨𝒊𝒋 = [𝒂
𝟐𝟏

𝒂𝟏𝟐
𝒂𝟐𝟐 ]

𝒂𝒊𝒋 = 𝒑𝒊 𝒑𝒋
𝒑𝒊 = [𝒄𝒐𝒔𝝍𝒊 ]
𝒔𝒊𝒏𝝍𝒊
𝒉𝒊
𝝍𝒊 = 𝐚𝐜𝐨𝐬 ( )
𝒍𝒊
𝝍𝒊 = 𝐚𝐜𝐨𝐬 (𝒉𝒊 /𝒍𝒊

where hi and li are the minor and major axes, respectively. Aij matrix represents the fiber
orientation.
2.6 Differential Scanning Calorimetry
Differential Scanning Calorimeter is used to measure the amount of heat required to raise
the temperature of the sample. This technique was carried out by considering the heat flow in the
sample and a reference pan. The sample that was considered here was nylon-glass fiber composite.
The difference in the amount of heat absorbed or released between the sample and the reference is
directly measured as a function of temperature during phase transitions. Power Differential DSC
and Heat flux DSC are the two types of Differential Scanning Calorimetry. Power Differential
DSC is carried out by maintaining the same temperature on both the sample and the reference and
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the power required to obtain and maintain the temperature is recorded. Whereas in Heat Flux
DSC, the same temperature is maintained for both sample and the reference and the difference
between the heat supplied to maintain that temperature is recorded. Heat Flow versus Temperature
curve is obtained from DSC. This change in heat flow can be calculated by integrating the ΔTref
curve (Fig 18). The DSC profile shown in the curves (Fig18), is heating-cooling-heating-cooling.
A heating rate of 10oC/min was used with nitrogen atmosphere around the sample with a flow rate
of 50mL/min.
Crystallinity refers to the degree of structural order in a material and strongly affects its
properties such as strength, density, and Young’s modulus. Higher value of degree of crystallinity
refers to the regularity of chains oriented in the sample. Additionally, higher degree of crystallinity
reduces the amorphous phase and typically leads to higher mechanical properties. The enthalpy of
100% crystalline PA6 depends on the polymerization process of the PA6 is 135 J/g for anionic
ring opening polymerization, which is the most common for PA6 [23]. Therefore, the degree of
crystallinity can be found by considering the area under the heat flow curve during the first melting
DSC cycle and normalizing it with the adjusted enthalpy value for 100% crystallinity. Based on
the glass fiber weight fraction of 30% in 3D printed composite the adjusted enthalpy is 94.5 J/g.
Upon this calculation the following degrees of crystallinity were found:
-

As printed: 32.05/94.5 = 0.34 = 34%

-

Annealed at 1700 C: 38.10/94.5 = 0.403 = 40.3%

-

Annealed and compacted at 2000 C: (30.69 + 12.69)/94.5 = 0.46 = 46%
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a.

b.
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c.
Figure 18:DSC Curves for pristine (a), annealed at 1700 C (b) and annealed with compaction at
200C (c)

The significant increase of degree of crystallinity was observed with increased annealing
temperature from 34% for pristine to 46% for annealed at 200 C.
Another noticeable difference was observed in the shape and temperature of the melting
peaks, corresponding to phase transition enabled by thermal treatment [24]. This phase transition,
especially in sub-Tm region has been shown to correspond to the improved mechanical properties
of nylon 6 [25].
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CHAPTER 3
RESULTS AND DISCUSSION
Load vs elongation data was obtained using TestWorks 4 software and then exported to a
spreadsheet for post processing. This data is used along with the original dimensions of the
specimen to construct a stress strain diagram. The mechanical properties such as modulus, ultimate
tensile stress was determined for each set of specimens. The results for each set of samples were
compared using tabulated means. On the other hand, the strain data obtained from the DIC plotted
vs the stress obtained from the TestWorks 4 which will generate the modulus. The modulus values
obtained from both the methods are compared.
3.1 Effect of Temperature and Pressure
The samples showed a change in their dimension when heat treated and there was a major
reduction in the thickness when the pressure was applied. Temperature has played a major effect
in increasing the tensile strength of the samples.

3.2 Evaluation of Degree of Compaction
Degree of compaction of the samples tended to decrease when annealed and furthermore a
decrease in thickness was observed when they were compacted at a higher temperature of 200° C.
The average thickness of the printed samples was found to be approximately 3.2mm and there was
a decrease in thickness ranging from 0.04mm to 0.74mm for 0 degree samples (Fig 19) and
0.13mm to 0.60mm for 90 degree samples (Fig 20). Among all the samples with 0-degree print
orientation, the samples annealed at 200C with compaction exhibit an increase in degree of
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compaction. It can be concluded that as the temperature is raised near to the melting point of the
composite along with pressure, the thickness of the composite material decreases. This is because
the annealing process along with compaction will result in the distribution of heat evenly
throughout the composite and the release of residual stresses introduced during 3D printing.

Degree of Compaction
0.25
0.23

Compaction strain
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0.00
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0.03
0.01
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-0.01
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200C

-0.05
Annealed

Annealed with compaction

Figure 19:Degree of compaction for samples with 0-degree print orientation.
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Annealed with compaction

Figure 20::Degree of compaction for samples with 90-degree print orientation.

3.3 Stress Strain Curves
The (Fig 21) shows the stress strain curve obtained from the tensile test on PA6 specimens.
The curve shows that the tensile strength increases with increase in strain and shows brittle fracture
as shown in (Fig 21). The tensile modulus is obtained by calculating the slope of the linear region
of the curve as represented in the figure. Similarly, Young’s Modulus for each sample is calculated
and their averages are compared.
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Figure 21:Stress strain curve for one of the annealed samples

3.4 Stress Strain Curves for Material Compacted and Annealed at Different
Temperatures
Samples compacted with 80psi tend to have higher strength of approximately 100MPa for
0 degree and 60MPa for 90 degree print orientation when annealed at 200°C than those annealed
at 150°C and 170°C for both 0 degree and 90 degree print orientation (Fig22) along with higher
value of strain.
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Figure 22:Stress Strain curves of 0-degree (Left) and 90-degree (Right) samples annealed at
temperatures 150°C: a) and d),170° C: b) and e) and 200° C: c) and f) with pressure of 80psi.
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Figure 23:Stress Strain curves of 0-degree (Left) and 90-degree (Right) samples annealed at
temperatures 150°C: a) and d),170° C: b) and e) and 200° C: c) and f) without pressure.

It is noticeable (Fig 23) that these 3D printed samples exhibit anisotropic behavior. The
samples exhibit higher strength and modulus in the printing direction/0-degree when compared to
the transverse direction/90-degree.
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3.5 Ultimate Tensile Strength and Engineering Moduli
Load and extension values with respect to time are obtained from the TestWorks 4
Software. The stress was calculated using load values and the horizontal cross-sectional gage area
of the specimen. Strain was calculated from the displacement of the crosshead and the gauge length
of the specimen. Using the stress vs strain curves, the modulus was obtained for each sample. Also,
strain is calculated using the percentage of elongation along the direction of the tensile load
recorded from the DIC and the original gauge length of the specimen. These strain values were
plotted against the stress values calculated from the TestWorks Software which gives the modulus.
A correction factor is calculated by taking the data from DIC and MTS and is applied to the results
obtained from the TestWorks. Thus, the tensile modulus for each set of samples are represented
using a bar chart as shown in (Fig 24) and Fig (25) with the error bars indicating the single standard
deviation for each set of samlples.
The samples follow a trend where there is increase in strength and modulus value as the
samples are annealed at 170C-150C and 200C with compaction. It can be observed that there is no
such effect on the strength of the samples when they are annealed at 150C with compaction. The
change starts at 170C and gives us a better strength and modulus at 200C.
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Figure 24: Elastic modulus of 0-degree samples compacted at 80psi and annealed at different
temperatures
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Figure 25:Elastic modulus of 90-degree samples that are compacted at 80psi and annealed at
different temperatures.

Fig 24 shows the 0 degree samples that are annealed at 150°C shows a higher modulus of
3.59GPa compared to the 200°C with modulus 6.36GPa and the 170°C being the least of about
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4.64GPa, also, Fig 25 shows that the 90degree samples that are annealed at 200°C has a modulus
of 3.92GPa which is greater 150°C with modulus 2.64GPa which is also comparatively greater
than the ones annealed at 170°C with modulus 2.27GPa. An increase in the modulus is achieved
from pristine samples to samples annealed at 200C with compaction. The tensile modulus values
for a few samples were discarded because either the DIC strain values were not recorded properly,
or the samples were damaged (bent) before testing.
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Figure 26:Tensile strength of 0-degree samples that are compacted at 80psi and annealed at
different temperatures
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Figure 27:Tensile strength of 90-degree samples that are compacted at 80psi and annealed at
different temperatures.

Samples compacted with 80psi at 200°C show extremely high ultimate strength of
95.79MPa (Fig 26) and 58.99Mpa (Fig 27) for both 0-degree and 90-degree print orientation. The
samples follow a trend in which the strength of the samples decreases from 75.48MPa to 58.56MPa
for 0 degree samples 24.63MPa to 24.12MPa for 90degree samples when the temperature is
increased from 150°C to 170°C and then it increases as it reaches the temperature of 200°C which
is near to the melting point of the composite, i.e., 206° C. Thus, the strength of the pristine samples61.29 MPa for 0degree and 20.37 MPa, increases upon annealing over 170° C. Annealing the
samples at 200° C with compaction increases both the strength and modulus of the sample
compared to the pristine and samples annealed at 150C with compaction.
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Figure 28:Elastic Modulus of 0-degree samples annealed at different temperature without
compaction.
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Figure 29:Elastic Modulus of 90-degree samples annealed at different temperature without
compaction.
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Figure 30:Tensile strength of 0-degree samples annealed at different temperature without
compaction.
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Figure 31:Tensile strength of 90-degree samples annealed at different temperature without
compaction.

Annealing of 3D printed samples without compaction does not greatly help in improving
the mechanical properties when compared to the ones annealed with compaction. However, an
improvement in strength and modulus is observed in samples treated at 150°C and 170°C for both
0- and 90-degree. The reduction in modulus and strength were found for samples annealed at
200°C in both printing and transverse directions. This result is largely due to the following, as
sample indicated by DSC the degree of crystallinity has increased significantly, causing

36

differential re-crystallization shrinkage in the material [26]. This shrinkage results in microscopic
cracking of the sample. The evidence of that can be seen for the 170°C annealed sample with and
without compaction as well. The micrographs in the following section demonstrate the presence
of microscopic voids between the beads. On the other hand, the increase of degree of crystallinity
in nylon has been shown to cause more of brittle like behavior [27]. Therefore, both effects can
explain why 200°C annealed sample demonstrates reduced properties.

Table 2: Strength and Modulus of samples treated at different temperatures and with/without
pressure.
0 degree

90 degree

Strength

St.dev

Modulus

St.dev

Strength

St. dev

Modulus

St.dev

(MPa)

(MPa)

(GPa)

(GPa)

(MPa)

(MPa)

(GPa)

(MPa)

61.29

5.46

3.59

0.37

20.37

0.61

0.88

0.01

150C

65.43

10.86

4.36

0.11

44.68

0.98

2.19

0.10

170C

72.57

10.72

4.54

0.32

32.42

1.25

2.30

0.04

200C

42.64

2.20

3.52

0.18

35.02

0.80

2.21

0.22

150 C

75.48

10.06

3.86

0.17

24.63

3.67

2.64

0.06

170 C

58.56

7.01

4.64

0.26

24.12

2.09

2.27

0.06

200 C

95.79

6.87

6.36

0.11

58.99

1.03

3.92

0.075

Pristine

Annealed
without
compaction

Annealed
with
Compaction
(80psi)
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3.5.1 Statistical Significance Test

Table 3: p-values obtained from t-test for comparison of modulus of pristine and samples with
other heat treatments.
Annealed with
Annealed

Pristine
150
4.36

170

200

150

170

200

4.54

Modulus
0-degree,

p-value

compaction

3.52

3.59

5.79
GPa
4.64
6.36
2.19
2.30

Modulus
90-degree,

0.88

2.21
2.64

GPa
2.27
3.92

0.0129

Significant

0.0141

Significant

3.7109E-06

Significant

0.081

Not
Significant

0.0079

Significant

1.6559E-06

Significant

1.1396E-05

Significant

2.3648E-07

Significant

0.0002

Significant

1.9815E-10

Significant

1.2172E-06

Significant

3.5007E-10

Significant
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Table 4:: p-values obtained from t-test for comparison of strength of pristine and samples with
other heat treatments.
Annealed with
Annealed

Pristine

p-value

compaction
150
65.43

170

200

150

170

200

0.08984

Not
Significant
Not
Significant

0.0026

Significant

0.0303
0.31140

Significant
Not
Significant

0.0001

Significant

1.6861E-06

Significant

5.7459E-05

Significant

7.3356E-06

Significant

0.0473

Significant

0.0203

Significant

8.82344E-10

Significant

0.2934
72.57

Strength
0-degree,

42.64

61.29

75.48
MPa
58.56
95.79
44.68
Strength

32.42

9020.37
degree,
MPa

35.02
24.63
24.12
58.99

A statistical significance t-test was carried out on the strength and modulus of the samples
treated at different temperature conditions. A one tailed t-test with two independent means was
carried out with 95% confidence level. A significance level, α=0.05 was chosen and the p-vales
are reported (Table3 and Table 4). The single standard deviation of each set of samples are
represented by error bars in each of the bar charts (Fig 25 to Fig 31). This independent samples ttest was conducted to compare the strength and modulus of pristine samples with each of the
sample set treated at different temperature and pressure.
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The t-test statistic values can be calculated from the following equations:
𝑆𝑝2

(𝑛1 − 1)𝑆12 ) + (𝑛2 − 1)𝑆22
=
𝑛1 + 𝑛2 − 2
𝑡0 =

𝑦1 − 𝑦2
1
1
𝑆𝑝 √𝑛 + 𝑛
1
2

where,
Sp2 is the pooled variance assuming equal variances in the samples
y1 and y2 are the means of the independent samples
n is the sample size and (n-1) refers to the degrees of freedom.
p-values were calculated in excel by considering a one tail t distribution.
Considering the comparison of modulus of pristine samples with one of the sample set, i.e., the
samples annealed at 150C. The following assumptions were considered for this case:
A sample size of n1=3 and n2=3 was considered for pristine and annealed at 150C without
compaction (Table 1).
By using the above equations, t0 is found to be 3.455081, tref = 2.131847, which means that the test
is statistically significant with p=0.01296694 where p≤0.05.
The p-values for each sample set were calculated using the same procedure by considering the
sample size as mentioned in (Table 1). A significant difference in the values for pristine and heattreated samples can be observed. These results suggest that whether the conditions of the heat
treatment used influences the strength and modulus. p-values≤0.05 indicate that the results are
statistically significant, and the heat treatment used influences the tensile strength and modulus of
the samples. Some of the p-values obtained are >0.05 indicating that the respective heat-treatment
used has no significant effect on strength and modulus with 95% confidence level.
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The samples annealed without compaction at 170 has p>0.05 indicating that annealing at
170C has no significant effect on strength and modulus in printing direction. This can be explained
by the presence of voids from the microscopic analysis conducted on the polished surfaces of the
fractured samples and the brittleness caused by the increase in degree of degree of crystallinity.
3.6 Micrograph Analysis
The micrographs for the 3D printed samples were analyzed using ImageJ software. The
images obtained from the microscopy have a length scale of 1mm, 2mm and 500µm with a scale
bar marked at the bottom right of the image with small line markings (Fig 32a). In case of the
below image, the length scale of the image is 2.00mm and 15.0kV is the voltage used to accelerate
the electrons while shooting the sample. Before analyzing, the image should be converted to 8-bit
mode, Image>Type>8-bit. For these types of images, the pixel value ranges from 0 to 255 in which
0 is taken to be black and 255 is taken to be white. The threshold of each image was manually
adjusted such that below the set value lies all the fibers and above which the matrix lies. This was
done by selecting B&W (Black and White) where fibers were distinguished from the matrix with
a dark background Image>Adjust>Threshold>B&W>Apply. The image with the set threshold can
be compared with the original image manually to differentiate between the fibers and the matrix.
With this threshold, the image is converted to binary such that the black background representing
the matrix and the white particles representing the fibers Process>Binary>Make Binary. These
Binary images were analyzed for the area of the Black region (Matrix) using Analyze>Analyze
particles. The same micrograph is inverted Edit>Selection>Make Inverse, such that the area of
fibers can be analyzed by following the same procedure. Similarly, the threshold of the image is
adjusted such that both the matrix and the fibers are together represented in black and the voids
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are represented in white as shown in figure (Fig 32b). This image can be analyzed to find the area
of voids using the scale mentioned at bottom right of the image (Fig 32a). and the remaining area
will represent the area of the matrix and fibers. Each of these areas including the area of matrix,
fibers and voids were used to find the volume fraction of each constituent Table (Volume fraction
of matrix, fibers and voids).

a.
b.
Figure 32:Polished cross section micrograph captured from optical microscope (a) and
analyzed image showing voids in white (b).

The micrographs clearly show that the void content decreases upon heating/annealing at
200C with the application of pressure. It is noticeable from the results (Table 5) that there is no
much decrease in void content when the samples are annealed at 170 C. But when comparing the
micrograph of pristine sample (Fig 33) and sample annealed with compaction at 200C (Fig 35),
the void content of the pristine samples tends to decrease from 37.71% to 3.40% (Table 5) as the
temperature of the reaches 200 C which is closer to the melting temperature 206 C. Since voids
act as crack initiation in a sample, the decrease in the void content will result in increase of
mechanical properties such as strength and modulus of the composite (Table 2).
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PS00
Figure 33: Micrograph of polished cross section of pristine samples with 0-degree print
orientation

170AC00
Figure 34:Micrograph of polished cross section of samples annealed at 170 with 0-degree print
orientation

200AC00
Figure 35:Micrograph of polished cross section of samples annealed and compacted at 200 C
with 0-degree print orientation
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3.7 Volume Fraction of Voids
The volume fraction of voids for the sample PS00 correspond to Fig33, 170AN00
mentioned in the table corresponds to the micrograph in the Fig 34. Similarly, the 200AC00
correspond to Fig 35. It can be observed that the void content tends to be relatively lesser for
compacted specimens compared to the as printed/pristine and the annealed specimens. This shows
that the compaction, which was previously reported, resulted in decrease of space between
individual beads and reduced void content.

Table 5:Volume fraction of voids
Sample

Volume fraction of voids

Pristine (PS00)

37.71

Annealed at 170 C
23.08
(170AN00)
Compacted at 200C
3.40
(200AC00)
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3.8 Fiber Orientation
The fiber orientation from the micrographs of the polished surfaces is calculated from the
equations mentioned in section 2.5.1.
For pristine sample: PS00B,
𝑨𝒊𝒋 = [

𝟎. 𝟔𝟏𝟎 𝟎. 𝟐𝟓𝟕
]
𝟎. 𝟐𝟓𝟕 𝟎. 𝟑𝟗𝟎

For sample annealed at 170o C: 170AN00B,
𝑨𝒊𝒋 = [

𝟎. 𝟓𝟒𝟕 𝟎. 𝟐𝟒𝟒
]
𝟎. 𝟐𝟒𝟒 𝟎. 𝟒𝟓𝟑

For sample annealed and compacted at 200o C: 200AC00B,
𝑨𝒊𝒋 = [

𝟎. 𝟔𝟏𝟗 𝟎. 𝟐𝟔𝟓
]
𝟎. 𝟐𝟔𝟓 𝟎. 𝟑𝟖𝟏

It is observed that the fiber alignment is retained even when the samples are heat treated with
compaction at 200C.
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CHAPTER 4
CONCLUSION
Nylon-glass fiber composites with desired shape and dimensions were obtained from 3D
printing. However, these samples did not exhibit higher strength and modulus due to weak bonding
between individual deposited beads. Post-treatment such as annealing resulted in an increase in
resin flow within the sample which in turn resulted in change in crystalline structure. Further
application of pressure at a temperature relatively closer to the melting temperature resulted in an
increase in the tensile strength and modulus.
Macroscopic deformation in the sample was investigated by determining the degree of
compaction. A compaction strain of 20% was achieved when the samples were compacted at 200C.
The reason for this change in degree of compaction can be explained by the microscopic analysis.
A reduction in the void content of pristine samples from 37.71% for pristine to 3.40% is achieved
by annealing with compaction at 200C.
The DSC results proved clearly that both modulus and strength of glass fiber composites
increase with increase in crystallinity. An increase in degree of crystallinity was observed for
samples compacted at 200C. It can be concluded that annealing of short fiber reinforced nylon at
200C with compaction pressure of 80psi exhibit improved strength and modulus without changing
its original shape.
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